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1 Welcome to Amprolyzer
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Seven good reasons why I use this Software as a 
Commissioning Engineer or Service Technician

1. Faster overview of the bus state without requiring knowledge of message
frames.

2. All bus information is continuously presented ONLINE, and the bus state
is summarized in a traffic light display.

3. Multiple buses can be monitored at the same time, provided that multiple
CP5611 are available.

4. Powerful Online filters and triggers.

5. All recordings are exported to Excel 
- a flexible, familiar standard tool 
- clear presentation of message frames 
- open interface by means of  VBA, that is, all message frames can be
further processed 
- powerful print functionality 
- powerful Offline filters via Excel mechanisms.

6. If recordings are passed on, the receiver does not have to install the
Amprolyzer tool, as long as Excel is available.

7. All Online and Offline settings can be saved at Profile files. They can be
created by experts and passed on to coworkers.
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2 What's new?

The tool Amprolyzer doesn't require a license key any longer. 

Attention: For using this Software you have to accept the license conditions, shown at the
download area and Setup!

You can install Amprolyzer V3.2 on the same PC on which V3.0 or V3.1 is already installed (see 
Parallel installations).
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3 Introduction

The ever increasing need for greater productivity requires a greater degree of automation in
production. More and more, control systems rely on decentralized I/O in connection with a field
bus system such as PROFIBUS. For achieving and maintaining a high availability of effective
production plants, operators must be able to detect and remedy the causes of errors as quickly
as possible. This requires powerful diagnostic systems in the form of tools and devices.

The so-called Advanced Multicard Profibus Analyzer (Amprolyzer for short) comes into play
here. This standalone application is a diagnostic software that logs message frames on the
PROFIBUS.

It helps you to find errors during commissioning and assists you with the concluding
documentation for the plant state.

If you do not yet have much experience with Online Help systems, you should first familiarize
yourself in the Help system with the structure of the user interface and the navigation elements. If
you already have experience in working with Online Help systems in a Windows environment,
you can simply get started – you will find additional information about the contents of each
chapter in the Overview.

Operation with the Keyboard:

If you do not have a mouse connected to your PG/ PC, you must operate the Online Help and
Amprolyzer using the keyboard. To do so, first read the section „Operation with Keyboard".
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3.1 Overview

Online help topics

Topics Chapter/Section:

You would like to install the software product Amprolyzer. Installation

You have installed Amprolyzer and would like to learn how to
operate it as quickly as possible.

Quick Start

If frames are recorded and you want to analyze them you need
the Offline mode.

Offline mode

You use already Amprolyzer and you want to set filters and
triggers during recording time.

Record Complex

Appendix Appendix
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3.2 Online Help

In this section, you will learn how to call up the information you require in the Online Help system.

The user interface is divided into three areas in which you can work: 
The Toolbar, the tabs "Contents", "Index" and "Search" and the Help window, which contains the
actual Help text. 

 



13Introduction

© 2007   SIEMENS AG

Toolbar:

 

Button
Name

Function

Hide Hides or shows the Contents, Index, and Search tabs.

Back Jumps to the most recently viewed page.

Print Opens a selection menu in which you can select the current
section or the entire chapter for printing

Options In addition to the functions mentioned, enables:
-  Jump to the next chapter section via FORWARD 
-  Jump to home page of Online Help
-  Interruption of an action (such as an animation) via STOP
-  Screen view update via REFRESH 
-  Individual settings of INTERNET-OPTIONS of Microsoft IE

Tab "Contents":

This tab shows you the structure of the Online Help.
Use this view to navigate between the different chapters and sections. To open a chapter,
double-click the book icon. You can open a specific section of a chapter by simply clicking the
page symbol.

Tab "Index":

This tab shows you all keywords of the Online Help.
Use this feature to display a specific keyword. First enter the required word in the input field. If
the word is found, the second step is to double-click an item from the list.

Tab "Search":

The Search tab allows you to perform an individual search in the Online Help. To use this
advanced function, first enter the required search term in the upper input field and then display it
via the "List Topics" button.
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3.3 Operation with Keyboard

Navigation at Online Help:

Key Combination Function

CTRL + TAB Switches between the Contents, Index, and Search tabs

ALT + O Calls Options menu

ALT + O +T Hides Contents, Index, and Search tabs

ALT + O + D Calls Print menu

ALT + O + I Calls Internet Options

Cursor arrows Selects section in Contents tab

RETURN Selects a section

Actions at Amprolyzer:

Key Combination Function

F1 Calls Online Help

SHIFT + F10 Right mouse button

ALT + corresponding underlined letter Performs the function of a button

Jump to radio button with TAB; Change value
with SPACEBAR

Changes value of a radio button

CTRL + PageUP or CTRL + PageDOWN Excel: Switches to another table page

CTRL + F Excel: Find

Press and hold Shift key and select
corresponding cells using the cursor buttons

Excel: Selects cell areas

CTRL + END Excel: Jumps to end of table area

CTRL + HOME Excel: Jumps to beginning of table area

Alt-Tab oder Alt-Shift-Tab Switches back and forth between Excel
workbooks

Additional Keyboard Commands:

Refer to Microsoft Excel help system.
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4 Installation

You want to install the software product Amprolyzer. It is important that you read this chapter.

Topic Chapter/Section:

You would like to know the system requirements of
Amprolyzer

System Requirements

You would like to connect Amprolyzer to your PROFIBUS
system

Hardware Connection

You would like to install, repair or uninstall Amprolyzer Setup
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4.1 System Requirements

System requirements for installing Amprolyzer:

· PC with a CPU with Pentium II or higher

· Microsoft(C) Windows 2000 SP2 or higher or
Microsoft(C) Windows XP Professional

· Microsoft(C) Excel 2000 or Excel XP or Excel 2003
- Excel 97 is sufficient for analysis of a recording saved in Excel (.xls).

· CP5611 or a PG with integrated CP5611 on a hardware base of PROFIBUS Asic ASPC2 Step
C/D/E2.

· This version of Asic can be read by Amprolyzer (see item "PcCard" at Online menu).

· Nonexistent functionalities are grayed if using an older Asic Step.

· For using all implemented features PROFIBUS Asic ASPC2 Step E2 is required.
If you do not have Step E2, you can possibly update your CP5611 PC card.

· By using a hardware trigger box, you can control Amprolyzer with hardsware signals or you
can get hardware signals generated by Amprolyzer. 
For more information, go to www.inomation.de. 

· Sufficient disk space (approximately 10 Mbytes) on the Windows system partition

· Administrator rights on this computer

The following devices are recommended as hardware:

· PG 740 PII or PIII by SIEMENS AG

· Power PG by SIEMENS AG

· Field PG by SIEMENS AG

· Celsius PC 400 / 600 or 800

· SINEC Professional PC

· PC SINEC Home

Depending on the number of available CP5611, you can use up to three CP5611 at the same
time, enabling you to monitor up to three bus systems at the same time. 
However, you can also use one CP5611 for Step7 and the other CP5611 for Amprolyzer. For
STEP7, a PCMCIA card (CP5511, CP5512) can also be used.

http://www.inomation.de
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Important information while using an Field-PG P4 2GHz:

· If you close the display, the ventilating grate will be covered.
· Then the warm airflow is blocked, the performance of the CPU will be decreased for limiting

the CPU temperature.
· The limited performance of the CPU can be the cause of a STOP („Internal Overrun") of the

recording on an 12 MBaud PROFIBUS.
· Therefore the display should never be closed during recording an 12 MBaud PROFIBUS,

neither on long term monitoring over night.

4.2 Hardware Connection

The following recommendations must be regarded to connect Amprolyzer to a PROFIBUS
system:

· Connection of diagnostic computer on the end of a bus segment:
The terminating resistance may have to be changed in this case.

· Connection to a station within a bus segment:
Note the maximum spur line length for the used baud rate.
For baud rates >= 1.5 Mbaud, use the active PROFIBUS cable
(MLFB:6ES7901-4BD00-0XA0) or connect directly to the PG socket on a repeater or
diagnostic repeater.

· The manufacturer doesn't assume any responsibility for any plant downtimes caused
by changes in the physical characteristics of the bus due to insertion of a spur line
when Amprolyzer is used!

· The Amprolyzer software is completely passive on the PROFIBUS. It does not use a
PROFIBUS address and does not send any message frames. It only listens passively to the
data exchange on the PROFIBUS.
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4.3 Setup

These instructions should make it easier for you to install, repair and uninstall the product quickly
and without errors.

Topic Example

How do I install the software? Installing

How do I repair the software? Repairing

How do I uninstall the software? Uninstalling

How can I update from a previous to current version? Parallel installations

General

· During installation, a log file is created and stored at "C:\Documents and Settings\All
Users\Application Data\Amprolyzer.log".

· If an OCX file of the folder WinDir\System32 has to be updated, a backup of the previous
OCX is created at the backup path "C:\Documents and Settings\All Users\Application
Data\Amprolyzer.log\ OCX_Save."

· During an uninstall operation, the state of the OCX file prior to installation is not restored.

· The Amprolyzer software can only use CP5611 devices that are displayed in the device class
SIMATIC NET of the device manager.

If there isn't any installed driver for a CP5611 it is shown as a network card and is therefore not
visible for Amprolyzer!
In this case, an additional installation of a SIMATIC NET driver is not required! 
Instead:
Install Amprolyzer, then perform a driver update via the device manager (display list of all
available drivers for this card), or remove card and perform a new search, or reboot the
computer.

· The security settings for Excel 2000 / Excel XP / Excel 2003 must be set to Medium, since the
"High" setting requires a "Digital certificate". 
Make this setting under EXCEL Tools / Macro / Security: Security level = Medium. 
If you fail to do so, the macros will not be activated, meaning that all buttons and all updates in
the Amprolyzer user interface will be inactive!
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4.3.1 Installing

An entire new installation is documented here to show you how to perform an installation.

1. After downloading the Amprolyzer zip-File, open it by a double-click and then double-click to
Amprolyzer.exe.

2. Then follow the displays and activate the Setup button

3. The software is unpacked and placed in a separate temporary directory, and the actual setup
routine appears.

4. The installation is started by pressing the Install button. In the next screen form, the target
directory for the installation can be specified.
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5. Confirm and accept the software license agreement for this product.
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6. Once you have successfully installed the drivers and the program, you should see the
following note.

7. If you want to use any other installed Amprolyzer version anytime, you can do it by repairing
the software product.
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4.3.2 Repairing

A repair is required in the following cases:

· You uninstalled an Amprolyzer version. Then the icon on the desktop and the Amprolyzer
program group are deleted entirely.
If you want to use another installed Amprolyzer version you have to repair it.

· You switch back and forth between different Amprolyzer versions.

· An OCX file in use has been corrupted by another application or overwritten with an old
version. In the last case, repair is necessary only if there is a visible error!

You can access Repair by going to Control Panel -> Add or Remove Programs -> Amprolyzer ->
Change/Remove.

and then Repair.



24 Amprolyzer Help

© 2007   SIEMENS AG

4.3.3 Uninstalling

You can access Uninstalling by going to Control Panel -> Add or Remove Programs ->
Amprolyzer -> Change/Remove.

and then Deinstall.
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4.3.4 Parallel installations

If you wish, you can have multiple, parallel Amprolyzer versions at the same time on one
PC:

In this case, the following rules apply:

· Use a separate installation directory for each version.
· In the programs group and on the desktop, you will always see the most recently activated

version.
· For activating a desired version, repair this version (see Repairing).

If you don't wish to have several Amprolyzer instances on one PC:

In this case you should uninstall the previous version before installing the new one.
If you do the uninstall process after installing the new Amprolyzer software you have to repair
the remaining version (see Uninstalling, Repairing).



Amprolyzer
for

Part

V

PROFIBUS 
diagnostic



27Quick Start

© 2007   SIEMENS AG

5 Quick Start

In this chapter, the basic functions of Amprolyzer will be presented. It is primarily intended for
users who want to learn the basic functions in the shortest time possible.

Topic Chapter/Section:

You would like to know the Basics of the Main Form Basics of Main Form

You would like to know the Basics of Online Mode Basics of Online Mode

You would like to know the Basics of Offline Mode Basics of Offline Mode

Short overview:

A typical scenario for diagnosing PROFIBUS includes the following steps:

1. By Add Bus you can select the CP5611 which is connected to your desired PROFIBUS line. 
The Amprolyzer driver will be installed automatically.

2. By all Online Modes ("Show BusState", "Record (Simple)" or "Record (Complex)") you can
view the state of your selected PROFIBUS line.
By the Online Modes "Record (Simple)" or "Record (Complex)" you can additionally record its
frames.

3. By the Offline Mode you can analyze the recorded frames. Here the standard tool Excel is
used.

4. At the end you release your allocated CP5611 by Remove Bus. Here you can install a different
driver for the CP5611 if you want to use it by other applications.
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5.1 Basics of Main Form

Start up Amprolyzer by performing one of the following actions:

· On the desktop:    Double-click the Amprolyzer icon OR

· In the Start menu: Single-click under Start -> Programs -> Amprolyzer -> Amprolyzer V3...

This startup operation sets up an interface that includes the functions described below.

  Sets up the driver on a selected CP5611 and displays the operating elements of
Amprolyzer for the associated Profibus line.

  Releases the selected CP5611 and exchanges its driver if desired.

  Displays a file from Amprolyzer version V2.0x.

  Calls the Online Help (not in this version), currently still via Start -> Programs ->
Amprolyzer -> Amprolyzer Help.

  Exit Amprolyzer.
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5.1.1 Add Bus

  provides access to a window where you can select your desired CP5611.

· Here, each CP5611 represents a field bus. For each CP5611, this function must be called
once.

· Each card is displayed with its driver name and location string exactly as in the device
manager of the system.

· Depending on the number of plugged CP5611, it is possible to install and monitor multiple
PROFIBUS lines.

You can add multiple buses by performing the  function repeatedly.

· After you have made a selection, the startup screen appears with one or several inserted
CP5611.

· You can now begin recording. This is referred to as the Online menu.
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Each bus name can be edited. 
This is useful if you monitor several PROFIBUS lines. In this way, the menu items can be better
assigned to the physical buses.
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5.1.2 Remove Bus

The button    provides access to a window where you can select your desired
CP5611 driver you want to install for the selected CP5611. At least two drivers are displayed.
The "SIMATIC CP5611" driver appears only if a STEP7driver is installed. 

· The driver for a CP5611 need only to be replaced if you want to use this CP5611 by other
products (such as Step7). If this is not the case, the drivers should not to be replaced because
of performance issues. 

· Select the driver "SIMATIC CP 5611" if you want to work with STEP7 or another
SIMATIC NET software afterwards.

· Select the driver "CP5611 Amprolyzer" if you want to continue using the card with Amprolyzer.
· The driver "CP5611 Dummy" is used within Amprolyzer during setup. Selecting this driver by

mistake does not cause any problem, since the driver is automatically replaced by the
Amprolyzer driver during the next Add Bus operation.

· Unfortunately, depending on the computer and the operating system, the driver exchange can
take several seconds, because the Microsoft update driver mechanism must be used here.
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5.2 Basics of Online Mode

Basic functions of Online Mode.
This mode is used for checking the bus state and for recording message frames.

Topic Chapter/Section:

Online-Mode "Show BusState":
You want to see the bus state,
but you don't want to record message frames.

Show Bus State

Online-Mode "Record (Simple)":
You want to see the bus state,
additionally you want to record message frames in an
easy way.

Record Simple 

Online-Mode "Record (Complex)":
You want to see the bus state,
additionally you want to record message frames by using
complex filters and triggers. 

Record Complex 

You want to change the Default Settings Default Settings
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5.2.1 Show BusState

By double-clicking to "Show BusState" in the Online menu, a screen form appears where you can
get information about the state of your bus.
This is referred to as the Online Info form.

For this purpose, at the right-hand section of the interface you can see three tabs, which
provide information about the Station List, occurred Events and the current Settings.

The left-hand section of the interface provides additional information about the bus state. The
displays are defined as follows:

Baud rate Current auto detected baud rate or set baud rate

Status Bus is active or the baud rate was not detected

Msg Counter Number of message frames counted since start of recording

Msg Rate Number of message frames per second

Msg trigger Number of trigger events that have occurred

Internal Overrun Number of overruns of the internal buffer list.
If this happens, the message or disturbance rate is too high. 
A "Driver too slow..." message then appears.

Running Displays tool activity

In addition to the event page, the state is indicated in the form of a traffic light. The traffic light
displays the state of the sum of all cells of the Event tab. If, for example, an event happens once
during the night, and if the Station List tab is displayed, the traffic light indicates that an event has
occurred!
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Traffic light color:

Green: No errors or repeats on the bus.

Yellow: Occasional occurrence of errors and repeats.

Red: Large-scale occurrence of errors and repeats.

 

The    button deletes the statistic counters, and the traffic light turns green again.

Example, if you monitor several PROFIBUS lines:
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5.2.1.1 Tab "Station List"

The tab "Station List" shows you all stations on the bus in different colors.

Foreground colors: 

Blue: Shows all passive stations.

Red: Shows all active stations.

Background colors:
 

Light yellow: Shows token repeats.

Yellow: Shows request repeats.
Both stations are marked if an request repeats appears between two
participants. This makes it easier to see which slave might be the problem.

Light blue: Shows DP slaves in diagnostics.
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5.2.1.2 Tab "Events"

On the tab "Events" the various bus states for a statistical analysis are counted.

This provides an immediate overview of all Online information, thus eliminating the need
to search through huge message frame recordings.

· Here, the information is displayed in two columns. The left-hand column provides information
about the absolute counter of an event, whereas the right-hand column reports the rate, that
is, how often the event occurred in the last second.

· A  traffic light indicates the state of the sum of all cells of the Event tab (see chapter Show
Bus State).

· By the Online Mode "Record (Complex)", it is possible to stop the recording when an event
occurs.
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Description of events when they occur:

Events Meaning

Bus

Timeout No bus activity could be detected during the specified timeout interval.
The Timeout interval can be set at the tab "Events" of the Online Mode "
Record (Complex)" if this mode is used. The default values used in the
Online Modes "Show BusState" and "Record (Simple)" are also
displayed there.

Syni Error The bus did not come to neutral position within 11385 bit counts 
(due to disturbances, for example).

ASIC

Rcve Overflow Should never occur under normal circumstances!
The Profibus Asic has already received a new message frame, although
the previous one has not been transferred to the memory.
If this happens, the message rate or disturbance rate is too high, or the
computer is too slow. A message "Asic too slow..." then appears.
Remedy:
Was the FdlStatus filter activated at 12 Mbaud?
Are the bus parameters set correctly?
If YES:
- If appropriate, activate additional Online filters.
- If appropriate, increase bus parameter Tid1 for active stations.
- If appropriate, increase bus parameter minTsdr for all stations.
- Disable temporary the Online Info (see Disable Online Info).

Fifo Error Should never occur under normal circumstances!
When a message frame was received, an internal Asic Fifo underrun
occurred.

Messages

Token Repeat Token message frame repeats are occurring. 

Request Repeat Request message frame repeats are occurring.

DP Slave
Diagnostic

Message frames with slave diagnostics are occurring.

Frame Error Invalid or incomplete message frames are occurring. This can result
from an illegal spur line causing reflections. 
Attention: Particular care must be taken to ensure that Amprolyzer is
properly connected to the bus structure (see chapter Hardware
Connection).)

Frame Error HW Invalid or incomplete message frames are occurring. This event can
only happen if it is activated at OnlineMode "Record (Complex)". It can
be used to generate a hardware signal when a frame error occurs. By
this signal an oscilloscope for viewing the state of the bus cable can be
triggered. 
You can buy a hardware trigger box by www.inomation.de.

http://www.inomation.de
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The column colors have the following meanings:

Counter Column:

Green: Event has not yet occurred.

Yellow: Counter >= 1

Rate Column:

Green: Event is not occurring at present.

Yellow: Rate = 1 to 9

Red: Rate >=10
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5.2.1.3 Tab "Settings"

The tab "Settings" shows an overview of the current Online filter settings.

Different Online filter settings are possible:

· Token filter
· FdlStatus filter
· Selectors

(Selectors indicate whether particular addresses or SAPs were selected during the recording).

At the Online Modes "Show BusState" and "Record (Simple)" all these settings are preset and
can be changed only temporary (see chapter Default Settings) whereas all Online filters can be
set at Online Mode "Record (Complex)".
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5.2.2 Record Simple

By double-clicking to "Record (Simple)" in the Online menu, you can see the Online Info form
as shown at mode "Show BusState". 
Additionally message frames are recorded.

· The mode "Record (Simple)" is a subset of the mode "Record (Complex)". For easier
operation, many parameters have been set to default values.

· Mode "Record (Simple)" is used to offer a fast recording without filters or triggers.
Recording stops as soon as all buffers of the CP5611 are full. This makes it possible for a
user who rarely works with this tool or who is using the tool for the first time to get a quick
overview of the bus message frames.
The stop condition can be temporary set to "Manual" by changing Default Settings.

· As soon as  is displayed with a red border, all buffers of the CP5611 are full (max.
996 messages), the recording is complete.
If you are interested you can look to the events that may have occurred up to this time.

· If you want to stop recording earlier, you can do it by the same button.

· After pressing the button the data are exported to Excel (see chapter Basics of Offline Mode). 
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5.2.3 Record Complex

The mode "Record (Complex)" is used to offer a detailed recording with Online filters and
trigger conditions.

· The recording can be stopped automatically as soon as the specified trigger conditions are
satisfied.
This enables experienced users to quickly obtain detailed information by the bus message
frames.

· The Online Modes "Show BusState" and "Record (Simple)" are a subset of "Record
(Complex)":

"Show BusState" corresponds to:
Use default values of "Record (Complex)" without recording of message frames.

"Record (Simple)" corresponds to:
Use default values of "Record (Complex)" except for the stop condition.
This is set to "Full Record Resource".

You will find more information about "Record (Complex)" in the "Record Complex" chapter.
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5.2.4 Default Settings

With the Default Settings you can temporary change the basic settings for the Online operations.

Attention:
At each start of Amprolyzer all Default Settings will be set to their factory value! 
This is done because some settings are very critical, it should not happen that they are changed
permanently.

Tab "Common":

· You can temporary disable the Online Info. 
This stops all driver accesses to the CP5611. As a consequence the Online information will no
longer be available! This will be indicated by a notice message.
(see also event "Rcve Overflow")

· You can temporary disable the HD4 checking if you see the event "Frame Error" and if you
want to know if this is caused by gaps between two message bytes.



43Quick Start

© 2007   SIEMENS AG

Tab "Record (Simple)":

· By filtering the message frames "FdlStatus Request" and "Token" the recording depth for data
frames can be increased.

· You can also set the default stop condition.

Tab "Show BusState":

· By default, message frames of type "FdlStatus Request" are filtered out for reducing the data
rate if more than one bus is monitored at 12 MBaud.
Checking of all FdlStatus Requests needs a lot of PC performance.

· If you deactivate the filter "FdlStatus Request", then it may happen that the computer will not
be operable as long as the bus cable is plugged and the message rate or disturbance rate is
very high (the displayed Online information is really determined ONLINE)!



44 Amprolyzer Help

© 2007   SIEMENS AG

5.3 Basics of Offline Mode

Basic Functions of Offline Mode. 
This mode is used for analysing recorded message frames by Excel.
Several worksheets with different functions are provided in an Excel file.This functions are
explained in this chapter.

One of the advantages of the Amprolyzer software is that a recording can be passed on to a
bus expert who will analyze the message frame recording. This is possible due to the following
issues:

· A recording is saved as an Excel file.
· This Excel file contains all settings made by its creator (Offline filter, comments, color settings,

etc.). 
Therefore the recipient of a recording immediately sees the same state as the sender.

· The recipient does not have to install the Amprolyzer tool. All that is required is Excel!

Topic Chapter/Section:

You want to see the details of all monitored message
frames

Worksheet "Messages"

You want to set Offline filters for reducing the number of
shown message frames

Worksheet "Filter Settings"

You want to change the font and color for the shown
message frames

Worksheet "User Settings"

You want to know the time intervals between marked
message frames

Worksheet "Time Marks"

You want to comment your recordings Worksheet "Comment"
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5.3.1 Worksheet "Messages"

You can use this worksheet to analyze message frames, which are recorded by the Online
mode.

The interface in this source worksheet is divided into four areas by a horizontal lines and different
colors

From Bottom to Top:

· Message frame window:
All recorded message frames are shown in this area.

· Data window:
Displays data of the selected message frame.

· Statusbar:
Provides information about the message frame recording of Online mode.

· Toolbar with the following buttons:

button "Settings": Changes formatting of the different columns and cells of the
message frame window

button "Filter": Applies and disables the Offline filter specified at Worksheet
"Filter Settings"

button "Export": Exports the current message frame recording to an non write
protected Excel file.
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Tips:

· You can use the internal search function of Excel to find desired frames or attention strings or
the trigger point provided by Amprolyzer. 
For example, you can use <Ctrl-F> and <++> to search for the trigger point or <Ctrl-F> and <#
> to find attention strings.
All possible attention strings are listed at column "Attention" of Worksheet "Help Filter".

· The column "User" is used to add comments about the message frames, for example, to notify
coworkers of particular situations. 

· In addition, time marks can be defined here (see Worksheet "Time Marks").

· More information about each column can be obtained in the tooltips. To view this
information, hover the mouse cursor for a few seconds over the relevant table header.

  

More in-depth information about the Messages worksheet

5.3.2 Worksheet "Filter Settings"

This worksheet can be used for creating Offline filters.

· Offline filters are used to reduce the quantity of data of a complete recording to a manageable
amount of message frames.

· The filters are set optimally if they leave only that rows which contain the exact information you
need to perform the bus analysis.

· The filter settings can be stored in a file (called a Profile) with a meaningful name. 
These Profiles can thus be reused and passed on to coworkers (who might not have as much
product knowledge as you).

More in-depth information about the Offline Filter worksheet
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5.3.3 Worksheet "User Settings"

With this worksheet, you can individually adjust the appearance of font and colors in the
message frame window.

· The color of each cell can be modified, but changing the font type and size affect the entire
message frame window, except for the Data1 to 246 column.

· User settings can be stored in a file (called a Profile) with a meaningful name. 
These Profiles can thus be reused and passed on to coworkers (who might not have as much
product knowledge as you).  

 

More in-depth information about the User Settings worksheet 
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5.3.4 Worksheet "Time Marks"

· Time marks can be defined in the Worksheet "Messages". The time interval between these
marked message frames is automatically calculated in the Worksheet "Time Marks".

· This gives you an overview of the time elapsed between time mark x and time mark y in a
recording.

More in-depth information about the Time Marks worksheet
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5.3.5 Worksheet "Comment"

Use this worksheet to append important information to your message frame recording, such as:

· Own comments
· Additional message frame recordings
· Excel tables
· Word documents
· Graphics
· Diagrams

More in-depth information about the Comment worksheet
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6 Record Complex

This section provides all the information you need to operate the mode "Record (Complex)".
This recording type should be used by experts to create a detailed recording for the fastest
possible error localization.
It assumes that you have precise knowledge of the processes on PROFIBUS.

Topic Chapter/Section:

You would like to get an overview of data flow during
recording

Tab "Overview"

You would like to know details about events Tab "Events"

You would like to set message frame filters Tab "Msg Filter"

You would like to set trigger conditions Tab "Msg Trigger"

You would like to increase the number of recordable
message frames

Tab "Record"

You would like to store your settings at User Profiles Tab "Profile"
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6.1 Online Info Form

By double-clicking to "Record (Complex)" in the Online menu and setting all parameters, you can
see the Online Info form as shown at mode "Show BusState" and "Record (Simple).
Additionally message frames are recorded according to your defined Online filters and trigger
conditions.

· The recording can be stopped automatically as soon as the specified trigger conditions are
satisfied.

· Then a corresponding notice appears, and you are prompted to press the  button.
If you are interested you can look to the events that may have occurred up to this time.

· If you want to stop recording earlier, you can do it by the same button.

· After pressing the button the data are exported to Excel (see chapter Basics of Offline Mode).
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6.2 Tab "Overview"

This tab appears after double-clicking to "Record (Complex)" in the Online menu It shows you
the data flow of message frames.

· You should be aware that if you use Online filters, some of the PROFIBUS data are no longer
available in Offline Mode. Consequently, some necessary information might be missing, or
your trigger might not even be activated. As a result, you might miss highly sporadic faults,
thus requiring more time and effort to localize and remedy the fault. 
We recommend to take some time at this point to familiarize yourself with the specific
processes on PROFIBUS.

· Double-clicking a block for which a tab with the same name exists, causes the corresponding
tab to be displayed.

· Data flow:
The picture shows that in the first step that PROFIBUS data are reduced by the Online filters (
Msg Filter).
In the second step, the filtered data are used to represent the Station List - as explained in the
Online Mode "Show BusState". The stations that were filtered out, are no longer displayed at
the Station List!
In the third step the recorded data length of a message frame is limited by the value which can
be defined at tab "Record".
Before recording a message frame to the internal buffer list of the CP5611 all trigger conditions
are checked.

Attention if using a trigger: 
If Online filters are used and/or the recorded data length is reduced, you must ensure that the
trigger event occurs in the remaining part of the remaining message frames!
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· Baud rate
Setting a specific baud rate make only sense if you start the Amprolyzer tool before the
PROFIBUS system and if you want to see the first message frame. 
If you use AutoDetect, the first message frames are lost due to the baud rate search.

· Stop Condition:
Use the stop condition to specify how the recording should be stopped. The trigger option is
automatically activated if you define a trigger.
Trick: By changing the stop condition, you can easily disable a triggers temporary.

· Msg Filter OFF:
Trick: This option allows you to disable your Online filters temporary in an easy way.
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6.3 Tab "Events"

In this tab, you can specify whether the recording should be stopped if a specific event occurs.

An event can be caused on PROFIBUS by the stations or physical bus characteristics (example:
station diagnostics).

· By default all occurring events from the tables "Msg Events" and "Bus/Asic Events" are 
counted and are visible at the tab "Events" of the Online Info form during recording time. 
There you can find a detailed description of all events too.

· As action you can also specify "Stop at trigger" and the recording will terminate as soon as
the event occurs. 
This provides a convenient, easy way of using basic events as triggers.



56 Amprolyzer Help

© 2007   SIEMENS AG

· For the event "Bus Timeout", the timeout time can be defined on the right-hand side of the
interface. In this way, specific timeouts on the bus can be used as triggers.

· With the Event "FrameErrorHw" it is possible to decide if a hardware signal should be created
by a Frame Error at Startdelimiter or afterwards (important for hardware trigger box).
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6.4 Tab "Msg Filter"

By this tab you can specify the filter settings for the recording of message frames.
Filters make it possible to filter out particular message frames (see Examples).

The following filters are available:

· FDL/Status Request filter
· Token filter

· Address and Address expansion (SAP) filters:

Filter Formats

SA/DA dec / hex 

SSAP/DSAP dec / hex 

SSAP/DSAP
Default

dec / hex 
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Some details:

· Depending on the used PROFIBUS Asic Step of your CP5611 you can define up to four filter
conditions.

· Filtering Token message frames is done only by activating the filter "Token", but not by the use
of address or SAP selectors.

· The address or SAP selectors can be linked together by specifying a number of hits per
message frame. 
Trick: If you use the hit number 0 then all message frames are recorded where no hit occurs
(see Examples).

· Depending on the Asic Step, the "Info" field at the bottom of the form shows you, for example,
whether the broadcast message frames are recorded.
These features are Asic-specific and thus cannot be changed.

· There is also an option to use the default address expansion as a filter.
The default SAP is used at the transfer of cyclic DP message frames. If you specify a filter
which filters out these cyclic frames, you get as a result the traffic of the acyclic data exchange
(see Examples).
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6.4.1 Examples

Note:
As already mentioned, the address filter has no effect on Token message frames!

Example 1:

· You only want to examine data traffic from/to station 72 and data traffic from/to station 85 (=
0x55) occurring on your bus. 

· Select >=1 as the number of hits. This will record all message frames in which Condition1 OR
Condition2 are satisfied. 

· Select the setting shown below.

Example 2:

· You only want to examine data traffic that is not done by the default SAP. 
· Select 0 as the number of hits. This will record all message frames that do not contain the

specified SAP. 
Because all cyclic message frames contain the default SAP, only the acyclic data traffic
remains. 

· Select the setting shown below.
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Example 3:

· You want to check whether the Sync/Freeze command function you programmed is going over
the bus.

· Select >=2 as the number of hits. This will only record message frames in which both
conditions are satisfied, that is, the two conditions are ANDed.

· Select the setting shown below.

Warning: 
Two hits will also be returned if SAP 063 appears twice in a message frame, that is, if
DSAP=SSAP=063! These message frames will thus also be recorded.

Example 4:

· In this example, all message frames are recorded where there are at least two hits.
· For example: 

DA=001, SA=002
DA=001, SA=001 (message frame to itself)
DA=001, SSAP=044
DSAP=033, SSAP=033 (2x same SAP)
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Example 5:

· In this example, only message frames are recorded where there are at least three hits.
· For example:

DA=001, SSAP=033, DSAP=033

Example 6:

· In this example, only message frames are recorded which do not contain Address 001 or
Address 002.
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6.5 Tab "Msg Trigger"

In this tab, you can define comprehensive, complex trigger conditions.
Triggers provide the option of reacting to a specific message frame content (see Examples).

The following trigger conditions are available:

trigger Formats

LenData dec / hex / bin

LenData/SA dec / hex / bin

SA dec / hex / bin

DA dec / hex / bin

FC dec / hex / bin

DA/FC dec / hex / bin

SSAP dec / hex / bin

DSAP dec / hex / bin

SSAP/DSAP dec / hex / bin

DATA(n) dec / hex / bin

DATA(n/n+1) dec / hex / bin
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Some details:

· Depending on the used Asic Step of your CP5611 you can define up to four trigger
conditions.

· The trigger conditions can be linked together by specifying a number of hits per message
frame. In addition, the stop condition can be defined.

You have the following options:
- Stop At trigger
- Count trigger
- Delay to the trigger event as a defined number of message frames.

· The trigger conditions can be defined individually in the lower left-hand part of the interface. An
overview of all specified trigger conditions is provided in the right-hand side of the interface.
This tree is merely for display purposes and cannot be edited!

· A trigger condition is being defined by an item, a bit mask, and a desired value.
A trigger condition is satisfied at a message frame if the value of the desired item ANDed
with the bit mask equals the desired value. This can also be used to verify whether all data
bits have a particular pattern.

Note:
The items are implemented by the Profibus Asic and thus cannot be changed.

Warning:
The Profibus Asic operates on a word basis and when it receives a message frame, it places a 0
in the last byte of the last word if the length of the received message frame is odd.
This also occurs with odd data lengths and when the acknowledgment SC is received.

· Case 1:
If you want to trigger at DataByte2=0, this condition is also valid if a message frame -
containing only 1 byte - is received, because the Asic has placed a 0 in the second data
byte  of the receive buffer. 
This could be handled in Profibus-Asic Step-E2 by defining a second condition (such as
LenData) and ANDing the two conditions (number of hits >=2). It might also be helpful to
define the entire data word DATA(n/n+1).

· Case 2:
If you want to trigger at SA=0, the trigger will also be initiated when a short
acknowledgement (SC) is received, because the Asic has placed a 0 in the word, and the
value of SA is therefore set to 0 in the receive buffer.
As in case 1, a second condition should be defined, or the LenData/SA word should be
used as an item.
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6.5.1 Examples

Example 1:

· You would like to trigger on slave failure with station address 25.
· This condition is satisfied when a message frame with DSAP=3C is sent to station address 25

(DA=025). Set the number of hits to >=2 to AND the two conditions.

Example 2:

· You want to record 300 more message frames after the situation that a sync command goes
over the bus to slave group 5.

· This is achieved with the following settings:
SSAP=3E
DSAP=3A
DataByte1=00100000
DataByte2=00010000.

· Since all 4 conditions must be satisfied simultaneously in a message frame, the number of hits
is set to 4.

· The DATA(n/n+1) item could also have been used to define the DataByte1/DataByte2 word.
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Example 3

· You would like to have the maximum post-history after the fourth analog input of the slave with
station address 65 has gone to a value of 820. 

· This is achieved with the following settings:
SA=065
DataByte7=008
DataByte8=020
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6.6 Tab "Record"

In this tab you can limit the number of recorded bytes of a message frame. 

· This enables you to make optimal use of the available memory of the CP5611 card. By
shortening the recording depth, you can increase the number of message frames available
in a recording.

· The data are then cut at the defined length.

· However, you should be aware that the data omitted in this way can no longer be used for
triggering.

Example:

· If you are operating Profibus DP only, and the largest data quantity for a slave is 6 bytes, then
you can increase the maximal number of recordable message frames by reducing the
message frame depth to 6 bytes: e.g. to 11873 message frames instead of 996. Your Excel file
and post-processing time will increase accordingly.

· If you unexpectedly have a slave with more data bytes than the defined value, this is indicated
in the message frame window of Excel by"??". 
All expected data bytes are symbolized by "??".
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6.7 Tab "Profile"

This tab enables you to save Profiles or reload and reuse existing Profiles for:

· tab "Events"
· tab "Msg Filter"
· tab "Msg Trigger"
· tab "Record"

In this way, Profiles for complex trigger settings can be made available to others. This feature
enables them to localize errors in their systems in a quick way.

When Profiles are reused, all parameters or just some of the parameters can be reused. It is
also possible to use a combination of different Profiles.

 Enables you to save all parameters you have defined since the start of "Record
(Complex)" in one Profile.

Resets all parameters of all tabs to the default values.

All parameters of an existing Profile can be loaded.

Only the parameters of the selected tab are loaded from an existing Profile.

Only the parameters of the selected tab are reset to the default values.
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7 Offline Mode

This chapter provides all of the information you need to analyze message frames recorded in
Online Mode. 
This is done by the standard tool Excel.

Navigation in Offline Mode

Offline mode has six subsections, called worksheets. To access a particular worksheet, left-click
the worksheet in the lower portion of the screen.

Detailed functions of Offline Mode

Topic Chapter/Section:

You would like to analyze your recorded frame messages Worksheet "Messages"

You would like to limit message frame presentation by filters Worksheet "Filter Settings"

You would like to change colors and fonts of the shown
message frames

Worksheet "User Settings"

You would like to do some time calculation Worksheet "Time Marks"

You would like to get a reference on filter settings Worksheet "Help Filter"

You would like to add comments such as accompanying
documents, tables, or graphics to facilitate diagnostics for
others

Worksheet "Comment"
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7.1 Worksheet "Messages"

This worksheet can be used to perform diagnostics on recorded message frames.

The interface in this source worksheet is divided into four areas by a horizontal line and a
different color:

In the position from bottom to top:

Topic Chapter/Section:

Message frame window:
All recorded message frames are represented in this
area.

The Message Frame Window

Data window:
Displays data for the selected message frame of the
message frame window

The Data Window

Statusbar:
Provides information about the message frame
recording in Online Mode

The Statusbar

Toolbar:
Settings, Filter, Export  

The Toolbar
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7.1.1 Message Frame Window

This window displays all message frames recorded in Online Mode.

Note:
The representation of the message frame window depends on the settings at the Toolbar, the
user settings, and the currently selected filters. 
For example, if you have hidden columns as a result of the settings, these columns will not be
visible in the message frame window.

Column
Name

Function

No. Indicates the name of the current message frame in ascending order.

User 1. Enter comments:
In this column, you can add comments about the current message frame.
Simply enter the required text in the corresponding cell.

2. Set Time Marks:
You can use this column to set so-called time marks. The time intervals
between marked message frames are automatically computed at Worksheet
"Time Marks".  

Syntactically, a time mark begins with a "T_" or "t_". In the second step, you
name the time mark. The time mark then looks like this: "T_Your Comments"
.

Attention This column displays all notes and error messages available for a message
frame.
Note:
If certain Online filters are used during recording (selection of
addresses/SAPs), it might not be possible to make an assertion regarding
repeats. Then the "Repeat ?" attention string appears in this case. The
Statusbar indicates if Online filters were activated during the recording.

Background:  
For detecting repeats, all message frames containing the FCB/FCV bits must
be available.
These two bits are part of the FC byte.

This problem can not occur if only the Online filters "Token" and "FdlStatus
Request" are used, since these types of message frames do not contain the
FCB/FCV bits.

Clock Time stamp of the ASIC after receiving the start delimiter.
The format can be changed by button "Settings" at the Toolbar.

Note: 
If a Online filter was used during recording, and the real interval between
message frames A and B is larger than 65536 Tbits, the time stamp for
message frame B may be wrong (and thus Tpre too).

Background:
The time stamp is generated by a 16-bit timer of the PROFIBUS Asic, which
may overrun. 
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The difference between the actual and the displayed time stamp can be  (n *
65536) Tbits (n=1,2,3, etc.).

Solution:
Ensure by your Online filters that the distance between two message frames
is never larger than 65536 Tbits.

TPre. Time elapsed between the end of last recorded message frame and the start
of the current message frame.
The format can be changed by button "Settings" at the Toolbar.

TPreNow Time elapsed between the end of last displayed message frame and the
start of the current message frame.
The format can be changed by button "Settings" at the Toolbar.
 
Note:
This time value is recalculated during each Offline filtering and is also only
available here. If all message frames are displayed again after filtering, the
previously filtered message frames are marked with a "#" sign (see button
"Filter" at the Toolbar).

TMsg Duration of message.
The format can be changed by button "Settings" at the Toolbar.

L2Service Service of current message at the Layer2 level

SD Start delimiter of current message

Adr Source and target address of current message.
The format can be changed by button "Settings" at the Toolbar.

SAP Source and Service Access Point of current message.
The format can be changed by button "Settings" at the Toolbar.

FC Function Code of current message.

LenMsg Number of bytes for current message at Layer2 level.

LenData Number of data bytes for current message at Layer2 level.

Data1...20 Data bytes of current message.
The format can be changed by button "Settings" at the Toolbar.

Data21...40...
etc

Data bytes of current message.
The format can be changed by button "Settings" at the Toolbar.

· The times are defined as follows:

 

Msg1 Msg2 

TMsg1 
LenMsg1 

TPre2 

Clock1 Clock2 

TMsg1 
LenMsg1 

· More information about each column 
is provided by the tooltips. To view this information, hover the mouse cursor for a few seconds
over the relevant column header.
(Note: The tooltips are implemented by commented Excel cells, these cells are marked by a
red triangle top right).
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7.1.2 Data Window

The data window always shows data of the selected message frame in the message frame
window. 

· This representation depends on the setting which can be done by button "Settings" at the
Toolbar.

· Use the data window to obtain information about a specific message frame at a glance.

· Hiding the data window:
In certain cases, it may be useful to hide the data window. This may be the case if you are
using a limited monitor resolution.
The hiding of the data window can be done by selecting "Data Window OFF"after pressing 
button "Settings" at the Toolbar.

· You can change the size of the data window with the   and  buttons.
This can be very useful in the DP environment, because often I/O data have only a range of a
few bytes. The tool Amprolyzer is preset for the entire 246 byte data stream.
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7.1.3 Statusbar

The upper area of the Messages worksheet provides information about the message frame
recording in Online Mode.

The following information is provided:

· Baud rate:
Displays the current bus transmission rate during the message frame recording.
The baud rate corresponds to the number of bits transferred per second for serial
communication. 

· Number of messages:
Indicates the number of recorded message frames.

· Max. number of data bytes:
Maximal number of data bytes of a message frame (see Online Mode "Record (Complex)").

· Use of Online Filter:
Indicates whether Online filters were activated during recording.
This is important for interpreting repeats and times (see Online Mode "Record (Complex)" and
Message Frame Window) .
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7.1.4 Toolbar

The most important settings for the Message Frame Window can be defined using the buttons "
Settings", "Filter" and "Export".

Button "Settings"

Use the button    to specify whether a column should be shown or hidden and in which
data or display format a column should be shown. 
Certain columns are not visible in the default settings.

· You can change the time-based representation of the Clock, TPre, TPreNow, and TMsg
columns in the message frame window. 
Multiple formats can be selected at the same time.

Click the desired combo box and select among the following:
- Tbit for bit time units
- usec for microseconds
- msec for milliseconds.

· You can change the representation in the columns "Adr", "Sap" and "Data" of the message
frame window. 
Click the desired check box and select among the following:

- dec for decimal
- hex for hexadecimal
- bin for binary

· Note:
Certain columns are mandatory for performing diagnostics on message frames. These
columns cannot be hidden. 
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Button "Filter"

With the button    you can enable or disable the filters defined in the Worksheet "Filter
Settings".

· The unfiltered representation of the message window is the default setting.
· If you define a filter at Worksheet "Filter Settings" and if you return to Worksheet "Messages",

then the filter is automatically applied and the button "Filter" is automatically pressed.
· You can switch back and forth between the filtered and the unfiltered representation by

pressing this button repeatedly. 
Previously filtered message frames are indicated by "#" in the column "TpreNow" so that they
can be viewed within the context of all recorded message frames.

· In the filtered representation, the intervals between the remaining message frames are
displayed in the TpreNow column.

Button "Export"

With the button    you can export the message frames to a new Excel Workbook which
is not write protected.
There you can process all exported data with VBA (Visual Basic for Applications). It enables you
to provide the data to any other application.
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7.2 Worksheet "Filter Settings"

By this Worksheet you can define Offline filters and limit the shown message frames at the
message frame window.

Topic Chapter/Section:

You would like to define a filter. 
Maybe the settings should be stored at a Filter Profile.

Defining a Filter

You would like to load an existing Filter Profile. Loading a Filter
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7.2.1 Defining a Filter

This section enables you to define a Offline filter and store it at a Filter Profile if desired.

· A filter consists of at least one row with one entry.
· Within a row, the entries of the columns are connected by a logical AND.
· If you use several rows then the rows are connected by a logical OR.
· A filter must start at the first available row. All rows after an empty row are ignored.

The first empty row found, signals the end of the filter!

· Trick: You can use an empty row to disable some filter settings temporary or to store some
other issues below the real filter conditions.

· Note also the format of the columns. You can change them to a customized format at any time

using the button   :

· At the Worksheet "Help Filter" you can familiarize yourself with the syntax and the possible
filter settings.

· Note: Filtering is implemented by the Advanced Filter of Excel.
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Example:

1. You would like to create a filter that only shows data exchange between stations 2 and 82.

· To do so, go to column "Adr" and enter "002 -> 082" in decimal format or "02 -> 52" in
hexadecimal format, depending on the format set for this column.

· If using an arrow, you must use the correct syntax (blank space before and after the
arrow).

· To facilitate this, the sample should always be copied from the Worksheet "Help Filter".

2. Additionally all stations currently providing diagnostic messages should be displayed.

· To enable this, go to the SAP column and enter filter conditions "060 -> 062"  (or
"060*062" if both Request and Response should be displayed). 

· Enter this setting in the second row so that it will be added by a logical OR to the first
defined row.

3. The diagnostic entries are only of interest if they are extended diagnostic entries.

· Go to the column "Data1 to 20" and enter "08*". Then Sap and "Data1 to 20" are
connected by a logical AND.



80 Amprolyzer Help

© 2007   SIEMENS AG

You can now use the button    to save the filter Profile at an own Excel file if you want
to reuse this filter. 
This is optional and spares yourself retyping a lot of filter entries. 

You can use the  button to reset all filters.

Note:
· If you define a filter at Worksheet "Filter Settings" and if you return to Worksheet "Messages",

then the filter is automatically applied and the button "Filter" is automatically pressed.
· You can switch back and forth between the filtered and the unfiltered representation by

pressing this button repeatedly. 
Previously filtered message frames are indicated by "#" in the column "TpreNow" so that they
can be viewed within the context of all recorded message frames.

· In the filtered representation, the intervals between the remaining message frames are
displayed in the TpreNow column.

7.2.2 Opening an existing Filter Profile

By the button    you can open an existing Filter Profile.
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7.3 Worksheet "User Settings"

By this Worksheet you can change the colors and fonts of the shown message frames.

Topic Chapter/Section:

You would like to customize colors and fonts. 
Maybe the settings should be stored at a User Profile.

Set Font and Color

How are default settings changed ? Changing Default Settings

· The  checkbox    disables the update capability for colors and font.

· However, this does not mean that the colors are removed!
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7.3.1 Set Font and Color

Here, you can customize the appearance of font and colors in the message frame window. 

· You can change the appearance by right-clicking the desired cell and selecting "Format Cells"
in the context menu.

· Change the font in the Font tab, and change the colors in the Patterns tab.
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Note:
Changes of the font type and size affect the entire message frame window, except for the
columns "Data x to y". 

·  The changes become visible when you select another cell.

· If you do not like the changes, you can go back to the default settings using the button "Reset".

· Confirm the changes by pressing OK or cancel the action by pressing Cancel.

· If you like the changes, you can save your settings at a Profile.

The  button allows you to save a Profile you have created and make it available to
others.

The  button and the file dialog box that appears are used to open a user Profile created
by you or someone else.

The  button resets current User Profiles and loads a default Profile supplied with the
product.

Changes do not necessarily have to be saved in a Profile. This can be done later, and should not
be done until the result has been checked in the Worksheet "Messages".
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7.3.2 Changing Default Settings

In certain cases, it may be useful to overwrite the factory default Profile. For example, if you want
to customize the appearance to fit your corporate design, you should overwrite the default
settings.

In the same step the settings of the other worksheets can also be changed permanently (for
example: which columns are displayed in which format, which columns are visible, etc.). These
new settings are effective each time a new recording is opened or displayed, since
Records.xlt is the used template file.

How to overwrite the default Profile:
 
1. Launch Microsoft Excel and open the file "Records.xlt", located at the Bin directory of the

installation folder. 
Records.xlt must not be opened by double-clicking at Explorer, as this will generate an new
instance (for example, Records1.xls)!

2. Modify the appearance of the message frame window according to your requirements.

3. Save the file as Record.xlt. 

Restoring the default user Profile:

If you want to restore the factory default Profile you should use the following procedure:

1. Launch Windows Explorer

2. Delete Records.xlt.

3. Copy Records_org.xlt to Records.xlt. Use always COPY instead of RENAME, otherwise you
will lose the original!
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7.4 Worksheet "Time Marks"

At this Worksheet you can see an automatic calculation of all time intervals between all message
frames marked with time marks.

· Time marks can be defined in the Worksheet "Messages".
A message frame can only have one time mark.

· All time mark combinations are taken into account.
· This gives you an overview of the time elapsed between time mark x and time mark y in a

recording.

Screen area Function

Baud rate Displays the current bus transmission rate during the message frame
recording in Online Mode. The baud rate corresponds to the number of bits
transferred per second for serial communication.

TimeMark x The time marks from the User column in the Worksheet "Message" are
shown here. Recordings can have up to 350 time marks.

TimeMark y The time marks from the User column in the Worksheet "Message" are
shown here. Recordings can have up to 350 time marks.

[Tbit] This column shows the time elapsed between TimeMark1 and TimeMark2
in Tbit format.

[Usec] This column shows the time elapsed between TimeMark1 and TimeMark2
in microsecond format.

[msec] This column shows the time elapsed between TimeMark1 and TimeMark2
in millisecond format.

[sec] This column shows the time elapsed between TimeMark1 and TimeMark2
in second format.

The displayed times corresponds to the difference between the start times of the marked
message frames.

 

Msg1 Msg2 

T(TimeMark1...TimeMark2) 

Clock1 Clock2 
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7.5 Worksheet "Help Filter"

This Worksheet provides you a compact help about the syntax and possibilities of the Offline
Filter.
The complete value range for each column is shown.
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7.6 Worksheet "Comment"

You can use this worksheet to append additional information, such as comments, documents,
tables, or graphics to the current message frame recording.

· It is also possible to add new worksheets to save additional information. Before you close the
recording you have to save the file.

· You should always document your message frame recordings sufficiently. You can help others
to quickly interpret similar bus faults by making your own results available.

· Use the standard EXCEL mechanisms for this purpose. 

Example: Insert a file

1. Select the cell in which you want to insert the file. At the Excel menu click "Insert ->
Object".

2. Switch to the "Create from File" tab.
3. Use the Browse button to select the required file.
4. Confirm your selection with OK or press Cancel to cancel the action.

Example: Enter comments

To do this, simply click in the required cell and enter the text. 

Recommendation:

Please document your results and conclusions about this message frame recording as
completely as possible. 
You can help others to interpret similar bus faults very fast by making your results available.
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8 Appendix

This appendix contains miscellaneous information for working with Amprolyzer.

Topic Chapter/Section:

Tips and Tricks Tips & Tricks

Tables Tables

References References

FAQ's FAQ
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8.1 Excel Tips and Tricks

Display of values: 

· Decimal values   are always displayed with three place markers, for example: Station 005.
· Hexadecimal values are always displayed with two place markers, for example: Station 05.
· Binary values   are always displayed with eight place markers, for example:

DataByte1=00110110.

Displaying Token Cycle Times:

For displaying the token cycle times, you must ensure that only token message frames are
displayed. 
To do so, you should enter "token."OR "token*"in the "L2Service" column. The cycle times will
now be visible in the column "TpreNow".

Display the time intervals between cyclic frames of same type:

For displaying this intervals, you must ensure that only message frames of the desired type are
displayed. 
The time intervals will then be visible in the column "TpreNow".

Hiding Cyclic Message Frames:

For hiding cyclic message frames, you must enter "*" in the "SAP" column. This hides all
message frames with a "blank SAP" (= default SAP).

Finding the trigger message or other Attention strings:

· Inside an recording it may be very laborious to find the message frame with the trigger mark.
Here you can use the standard Excel mechanism to search for a string inside an document.

· By Excel menu "Edit -> Find" or "CTRL+F" and then typing "++" or "#" or. "##". 
- The message trigger is marked with "++".
- The events are marked with "#" or "##" (see Worksheet "Help Filter").

Defining Offline filters:

· look to Worksheet "Help Filter".

· An empty row marks the end of the filter condition(s). All entries below the empty row will not
be used for the filter.
Tip: If you filter an recording with different criteria you can save the different filter criteria by
moving the empty row without typing the filter again and again.

· Using wildcards in columns: If you use only an asterix "*" and no other sign as filter item, you
get all message frames where this field is not empty.

· The comparison-operators (<, >, =) cannot be used in the fields of data, because the data are
saved as strings. Strings cannot be asked by comparison operators.
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8.2 Tables

This section of the appendix presents several useful tables and references to tables that are
created by experienced users of PROFIBUS.

Topic wird beschrieben in:

List of most frequently used SAPs SAP Overview

Decoding tables for L2 message frames L2 Decoding Tables



92 Amprolyzer Help

© 2007   SIEMENS AG

8.2.1 SAP Overview

These service access points are used to select the various DP functions: 

DSA
P
dec

DSA
P
hex

SSA
P
dec

SSAP
hex

Description Function

NIL NIL User data exchange DATA_EXCHANGE

00-1
9

00-1
3

50 32 DP/T  MPI connections

20-4
8

14-3
0

50 32 DP/T  DP connections

49 31 49 31 Resource manager CON_DISCON

50 32 50 32 PC/PG channel, all PG functions
51 33 51 33 Data record handling DS_RW

52 34 52 34 Transfer an operating state
53 35 53 35 Slave to Slave Parameter SL_TO_SL

54 36 54 36 Master Master function, such as
Upload/Download

55 37 62 3E Slave Address assignment SET_SLAVE_AD
R

56 38 62 3E Read inputs RD_INP

57 39 62 3E Read outputs RD_OUT

58 3A 62 3E Send control commands GC

59 3B 62 3E Read configuration data GET_CFG

60 3C 62 3E Request slave diagnostics SLAVE_DIAG_R
EQ

61 3D 62 3E Set parameter assignment data SET_PRM

62 3E 62 3E Check configuration data CHK_CFG
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8.2.2 L2 Decoding Tables
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8.3 References

If you would like to read more about PROFIBUS or need more information about a particular
topic, a concise list of references is provided here.

Do you want to learn more about a particular topic? In-depth references?

Do you need detailed information about PROFIBUS and PROFIBUS standards specifications?
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8.3.1 In-Depth References

In-depth references

 

What other references are available?
The following documents contain additional information about PROFIBUS
 
/1/ Network manual for PROFIBUS
Siemens AG

/2/ PROFIBUS DP/DPV1 
Author: Manfred POPP
ISBN: 3778527819

/3/ Decentralization with PROFIBUS-DP/DPV1
Author :Josef Weigmann
ISBN: 3895781894
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8.3.2 PROFIBUS Specifications

The basic specifications for PROFIBUS are available on the PROFIBUS User Organization
(PNO) homepage of the PNO at www.profibus.com

/1/ EN 50170–1–2: 1996
General Purpose Field Communication System
Volume 2 : Physical Layer Specification and Service Definition

/2/ PNO Guideline:
PROFIBUS–Implementation notes for draft DIN 19245 Part 3
Version 1.0 dated Dec 14, 1995

/3/ PNO Guideline:
Optical Transfer Technology for PROFIBUS
Version 2.1 dated Dec '98

/4/ EIA RS–485: 1983
Standard for Electrical Characteristics of Generators and Receivers
for Use in Balanced Digital Multipoint Systems

/5/ IEC 61158–2 to 6: 1993/2000
Digital data communications for measurement and control –
Fieldbus for use in industrial control systems

http://www.profibus.com
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8.4 FAQs

 
Here, you will find the most frequently asked questions relating to Amprolyzer.

In general, all problems are shown with a detailed error description if the question relates to a
known or expected problem.
 
General FAQs
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8.4.1 General FAQs

Installation 
STEP7
OCX Error
Offline Mode
Error Messages

Installation:

Amprolyzer can't be installed?
· For installation, Amprolyzer requires administrator rights on the computer.
· An OCX on the computer has been renamed and is therefore no longer available.

STEP7:

STEP7 is no longer going Online?
· Check whether you have installed the drivers for STEP 7 when exiting Amprolyzer.

OCX-Error:

What is a runtime error with an OCX ?
· During installation, it does not matter what the state of the OCX files is. If the required OCX is

not yet available, it will be installed by the setup. Old OCX files are replaced by more recent
files.

· The runtime error may occur in the following situation:
Another software has restored an OCX with a version number from e.g. 2000, and it has thus
received a new file date. As a result, it will not be replaced by the Amprolyzer setup with an
OCX recommended by Amprolyzer. This error is expressed as a runtime error when this OCX
is used. The name of the OCX is displayed in text form.

· Remedy:
Rename this OCX in the win\system32 directory and restart the setup or initiate Repair if the
runtime error occurs only when Amprolyzer is used.

Offline Mode:

Why aren't there any actions in Offline Mode?
· The macros were not activated during opening the Excel file.

Error Messages:

What does"Driver was too slow...?" mean?
· The internal buffer list of the CP5611 has an overrun. If this happens, the message or

disturbance rate is too high.
· Check: Is the Online filter "FdlStatus Request" activated if using 12 Mbaud?

If YES:
- If appropriate, activate additional Online filters.
- Activate "Disable Online Info" at the Default Settings. Now, the driver will no longer try to get
Online info. This will be indicated by a notice message.
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